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Android is the most used mobile OS all over the world. Making an Android app is not as difficult as you think of. You just need to have less knowledge on the Android structure and little Java programming. How do you make an Android app? Do you ask questions below? How Create Android applications for beginners? How to create an Android app
with a few lines of code? Create a project Well Android, in steps you will help you to build your first Android Application. Before starting A ¢ here is the final result of our application. All you need to know to write your first Android application Step-1 This tutorial will help you create your Android FirstA ¢ app with the help of Android Studio. The
question is very increased with Android applications as it is never ignored completely. Android Studio is an easy to use software that will help develop better applications with simple interactive applications. This tutorial will take you around 30-60 minutes, depending on how fast you can download and install Android Studio. After using this tutorial to
create your first Android application, youA ¢ LL being on the right road for a new hobby fun or perhaps even a promising mobile development career. Step by step procedure for the development of Android apps easily. 1std, Install Android Studio: First of all you need to download Android Studio to make the Android application. To download it go to a
€, for the Android Studio download. Use the default installer to install Android Studio following the instructions. You can easily download and ita s arrangement of all users free without further frantic passages. Step-2A Open a new project Start Android Studio. You will open guided Quick Start called in the quick start menu, click Start a new Android
Studio project. In the Create new project window that you will open the Wizard Project information and by default is to give your application name for CrunchifyHelloWorld. Then you need to add the package name that could contain the name of the company. You can give name, if you wish. In our case we provided the package name:
tutorials.crunchify.com then choose where you want to store the project. So choose the project path. Click Next. Step-3 Make sure that on that phone and tablet is the only dialogue that is checked. If you want to check the application on your phone, make sure that the minimum SDK should be under the MobileA ¢ s operating system level. Click Next.
Step-4 Select Activity, vacuum from the list of all activities. Click Next. Leave all the fields of the activity name as well as. Click Finish. This creates project structure like this: step-5. Open the Activity Main.xml file double-click the Activity Main.xml file. Click on TextView -> Change text value to your desire to text Click the button from the clickable
palette and the Drag button to be centered under your welcome message. Make sure the button is still selected. In the Property menu (on the right side of the window), scroll down to find the field for text. Change the text from New Button to the next page. Method Step 7.a Write button onclick () Open MainActivity.java file.
Com.Crunchify.Tutorials.CrunchifyhelloWorld package, the Android.Content.Intent import, the Android.S.Bundle import, the import Android.support.v7.app.AppCompatactivity, the import Android.view.view, 1 'import android.widget.button; Public Class MainActivity Extend AppCompatActivity {A, A, A, A, Protected Oncreate void (bundle
saviintancestate) {A, A, &, A, A, A, &, super.oncreate (savedinstancestate); A, A, A, A, A, A, &, &, setcontentview (r.layout.activity main); A, A, A, A, A, A, A, &, button = (button) findviewbyid (r.id.button); A, A, A, A, A, A, A, &, button.setonclicklistener (new view.onclicklistener () {A, A, A, A, A, A, A, A, A, A, &, A, Public void onclick (View v) {A, A, A, A,
gotosecondactivity private void () {A, A, A, A, A, A, A, A, intent intent = new intent (this, secondactive.class ). Just replace it with code above Step- 8 Create files secondActivity.java under the same file position as MainActivity.java package com.Crunchify.Tutorials.CrunchifyhelloWorld; *. *. From Crunchify the 7/5 / 17.Public Reportivity Class {Test the
application by clicking on Run button and you will see the popup device selection. Select Pixel API 26 and click OK. You should now see your application running under Android phone simulation. And you're done! Congratulations. If you liked this article, please share it on social media. You still have questions about an article, leave you a comment.
This practical codelab is part of Unit 1: preliminary operations in the Android developer fundamentals (version 2) of the course. You will get the maximum value from this course if you work through the sequential codeslabs: Note: This course uses the terms "codelab" and "practical" interchangeably. Introduction In this practice you learn how to
install Android Studio, the Android development environment. You can also create and manage your first Android application, hello world, on an emulator and a physical device. What you should already know that you should be able to: Understanding the software development process in general for object-oriented applications using a (integrated
development environment) IDE as Android Studio. Prove you have at least 1-3 years of experience in object-oriented programming, with some of it focused on the Java programming language. (These exercises will not explain object-oriented programming or Java language.) What you will need a computer with Windows or Linux operating system, or a
running Mac MacOS. See the Android studio download page for up-to-date system requirements. Internet access or an alternative way to upload the latest Android Studio and Java installations on the computer. What you will learn how to install and use the Android Studio IDE. How to use the development process for creating Android applications.
How to create an Android project from a model. How to add log messages for your application for debugging. What will you install the Android Studio development environment. Create an emulator (virtual device) to run your application on your computer. Create and run the Hello World application on virtual and physical devices. Explore the project
layout. Generate and view log messages from your app. Explore the AndroidManifest.xml file. After successfully installed Android Studio, you will create a new project for the Hello World application from a model. This simple display app The "Hello World" string on the screen of the Android virtual device or physicist. Here is that the final application
is similar: Android Studio provides a complete environment of integrated development (IDE) including an advanced code editor and a series of app models. Furthermore, it contains development tools, debug, testing, and performance that make it faster and easier to develop applications. You can check your applications with a wide range of
preconfigured emulators or your mobile device, build production applications, and publish on Google Play Store. Note: Android Studio is continuously improved. For the latest information on system requirements and installation instructions, see Android Studio. Android Studio is available for computers running Windows or Linux and for running
MacOS. The last Openjdk (Java Development Kit) is supplied bundled with Android Studio. To get installed and working with Android Studio, first check the system requirements to ensure that the system encounters them. The installation is similar to all platforms. Any differences are indicated below. Go to the Android Developers website and follow
the instructions to download and install Android Studio. Accept default configurations for all steps and make sure all They are selected for installation. After finishing the installation, the installation wizard will be downloaded and installed some additional components, including the Android SDK. Be patient, this could take some time depending on the
Internet speed, and some of the steps may seem redundant. When the download is completed, Android Studio starts and you're ready to create your first project. Troubleshooting: if you run in With the installation, check the release notes of Android Studio or get help from the instructors. In this task, you will create an app that shows "Hello World" to
verify that Android Studio is installed correctly and to learn the basics of development with Android Studio. 2.1 Create the App project Open Android Studio if it has not already been opened. Welcome Welcome to the Android Studio window, click Start a new Android Studio project. In the Create Android project window, enter Hello World for the
application name. Verify that the default location of the project is where you want to store your Hello World app and other Android Studio projects or change it to your favorite directory. Accept the preset android.example.com for the business domain or create a unique business domain. If you are not going to publish your app, you can accept the
default value. Keep in mind that changing the package name of your app later is an extra job. Leave the options deselect to include C ++ support and include KOTLIN support and click Next. On the Target Android devices screen, the phone and the tablet must be selected. Make sure that API 15: Android 4.0.3 IceCreamsandwich is set as a minimum
SDK; If it is not, use the popup menu to set it. These are the settings used by examples in lessons for this course. Starting from this writing, these settings make your Hello World app compatible with 97% of active Android devices on Google Play Store. Leave the support Include Incente App and all other options. Then click Next. If your project
requires additional components for your selected destination SDK, Android Studio will install them automatically. The Add a window of activity window appears. An activity is a single thing focused that the user can do. It is a crucial component of any Android app. A business generally has a layout associated with it that defines the way Ul elements
appear on a screen. Android Studio provides activities of activity to help you get started. For the Hello World project, choose empty activity as shown below and click Next. The Configure Attivities screen appears (which differs depending on the model you have chosen in the previous step). By default, the empty activity provided by the model is called
Mainattivita. You can change it if you want, but this lesson uses the Mainativita. Make sure the option generates the layout file is selected. The default layout name is _main activity. You can change it if you want, but this lesson uses Activity Main. Make sure that the compatibility option backwards (App Compat) is selected. This guarantees that your
app is backward-compatible with previous versions of Android. Click Finish. Android Studio creates a folder for your projects and builds the project with a gradle (this may require some moments). Tip: Refer to the configures your build developer for detailed information. You can also see a message "Suggestion of the day" with keyboard shortcuts and
other useful tips. Click Close to close the message. The Android Studio editor appears. Follow these steps: Click the Activity main.xml tab to view the layout editor. Click the design tab of the layout editor, if it is not already selected, to show a graphic reduction of the layout as shown below. Click the MainActivity.java tab to view the code editor as
shown below. 2.2 Explore the project> Android panel in this practical, you will explore how the project in Android Studio is organized. If it has not already been selected, click on the Project tab in the Vertical tab on the left side of the Android Studio window. The project panel appears. To view the project in the standard Android project hierarchy,
select Android from the popup menu at the top of the project pane, as shown below. Note: This chapter and other chapters refer to the project pane, when set to Android, such as the Android project panel> 2.3 Explore the script folder Gradle the Body Build system in Android Studio simplifies the inclusion of external tracks or other modules of
Library for your construction as dependencies. When before An App project, the project> The Android pane displays the Script folder Gradle expanded as shown below. Follow these steps to explore the Gradle system: if the script folder Gradle is not expanded, click the triangle to expand. This folder contains all the necessary files from the build
system. Search build.gradle file (Project: Helloworld). This is where you will find the configuration options that are common to all the modules that make up your project. Every Android Studio project contains a single build Gradle parent file. Most of the time, you do not make changes to this file, but it's still useful to understand its contents. By
default, the upper level build file uses the BuildScript block to define the repositories and gradble dependencies that are common to all the project modules. When addiction is something different from a local library or a file tree, Gradle looks for files in which the online repositories are specified in the repository of this file locking. By default, the new
Android Studio projects declare JCenter and Google (which includes Google Maven repository) as the repository positions: Allprojects repository {{Google () jcenter ()} } Search Module (build.gradle file: App ). In addition to the project level build.gradle files, each module has its own build.gradle files, allowing you to configure the compiler settings for
each specific form (the app Helloworld has only one module). The configuration of these build settings allows you to provide custom packaging options, such as additional types of filling and product flavors. You can also override the settings in AndroidManifest.xml or build.gradle top-level file. This file is more often the file to edit when changing
configurations in terms of apps, such as the declaration of dependencies in the Dependencies section. You can declare a dependency from the library using one of several dependency configurations. Each dependency configuration provides Gradle different instructions on how to use the library. For example, the statement FileTree implementation
(say: 'libraries', include: [ '* .jar']) adds a dependency of all the ".jar" file inside the libs directory. Below is shown the Build.Gradle file (module: app) for the app Helloworld: apply plugin: 'com.android.application' Android {{compilesdkversion 26 defaultconfig applicationID "com.example.android.helloworld" minSdkVersion 15 Targetsdkversion 26
VersionCode 1 VersioneName "1.0" TestinstrumentazioneRunner "Android.support.test.Runner.androidjunitRunner" BuildTypes} {{Release MinifyEnabled False ProguardFiles GetDefaultProguardFile ( 'Proguard-Android.txt'), 'Proguard-rules.Pro'} } } Dependencies {Implementation FileTree (Dir: "libs", includes: [ * .jar']) Implementation
‘com.android.support:26.0' Implementation 'com.android.support.constraint: constraint-layout: 1.0.2' Testimplementation ' JUnit: Junit: 4.12 'Androidtestimplementation' com.android.support.test: Runner: 1.0.1 'Androidtestimplementation' com.android.support.test.espresso: Espresso-core: 3.0.1 '} Click the triangle to close Script Gradelle. 2.4
Explore the APP and RES folders All codes and resources for the app can be found inside the app and RES folders. Expand App folder, the Java folder and the folder to see the Java Com.Example.android. HamFEllold Mainactivity file. Double-clicking the file opens in the code editor. The Java portfolio includes Java class files into three subfolders, as
shown in the figure above. COM.Example.Hello.Hellollorld (or domain name that you specified) The folder contains all the files for a package of app. The other two folders are used for the test and described in lesson. For the Hello World app, there is only one package and contains MainActity.java. The name of the first activity (screen) sees the user,
which also initializes the resources at the app level, is customizedly called MainActivity (file extension is omitted to the Android panel). Expand the RES folder and layout layout And double-click the Activity main.xml file to open it in the layout editor. The RES folder contains resources, such as layouts, strings and images. A business is usually
associated with a Layout of UI views defined as an XML file. This file is usually named after your business. 2.5 Explore the Manests folder The Manifests folder contains files that provide essential information about your app to the Android system, which the system must first have any code of the app. Expand the manifest folder. Open the
AndroidManifest.xml file. The AndroidManifest.xml file describes all the components of your Android app. All components for an app, like any activity, must be declared in this XML file. In other course lessons, you will modify this file to add functionalities and functional authorizations. For an introduction, see Overview of the Poster App. In this
activity, you will use the Virtual Device Android (AVD) manager to create a virtual device (also known as emulator) that simulates the configuration for a particular type of Android device and use that virtual device to run the app. Note that the Android emulator has additional requirements beyond the basic requirements of the Android Studio system.
Using the AVD manager, defines the hardware features of a device, its API level, storage, skin and other properties and save as a virtual device. With virtual devices, you can test the apps on different device configurations (such as tablets and phones) with different API levels, without having to use physical devices. 3.1 Create an Android virtual device
(AVD) To run an emulator on your computer, you need to create a configuration that describes the virtual device. In Android Studio, select Tools> Android> Avd Manager or click the AVD Manager icon in the toolbar. The screen of your virtual devices is displayed. If you have already created virtual devices, the screen shows them (as shown in the
following figure); Otherwise see an empty list. Click on the device + Create virtual device. The Select Hardware window appears showing a list of pre-configured hardware devices. For each device, the table provides a column for the size of the diagonal display (dimensions), the resolution of the pixel screen (resolution) and the density of the pixel
(density). Choose a device like Nexus 5x or XL pixel and click Next. The system image screen appears. Click the Recommended tab if it is not already selected and choose the version of the Android system to run on the virtual device (like Oreo). There are many more versions available than the shown in the recommended tab. Watch X86 images and
other image cards to see them. If a download link is visible next to a system image you want to use, it is not yet installed. Click the link to start the download and click Finish when it's done. After choosing a system image, click Next. The Android Virtual Device window (AVD) is displayed. You can also change the name of the AVD. Check the
configuration and click Finish. 3.2 Run the app on the virtual device in this activity, you will finally run your Hello World app. In Android Studio, choose Run> Run App or click the Run icon in the toolbar. The Select Target Deployment window, under available virtual devices, select the virtual device, which you have just created and click OK. The
emulator begins and boots just like a physical device. Depending on the speed of the computer, this may take a while. Your app builds, and once the emulator is ready, Android Studio The app on the emulator and execute it. You should see the Hello World app as shown in the following figure. Tip: During the test on a virtual device, it is a good
practice to start it once, at the beginning of the session. You shouldn't close it until you have finished testing your app, so that your app has not again through the device startup process. To close the virtual device, click the X button at the top of the emulator, select Exit from the menu or press Control-Q in Windows or Command-Q in MacOS. In in
final task, You'll run your app on a physical mobile device like a phone or tablet. You should always test your apps on virtual and physical devices. This you need: an Android device like a phone or tablet. A data cable to connect the Android device to the computer via the USB port. If you are using a Linux or Windows system, you may need to perform
additional steps to be performed on a hardware device. Check the documentation using hardware devices. You may also need to install the appropriate USB drivers for your device. For USB drivers based on Windows, see the OEM USB drivers. 4.1 Enable USB debugging To enable Android Studio Communicate with your device, you need to enable
USB debugging on your Android device. This is enabled in the developer options settings of your device. On Android 4.2 and higher, the Developer Options screen is hidden by default. To show options for developers and enable USB debugging: the device, open the settings, try the phone, click Telephone and touch Build number seven times. Go back
to the previous screen (Settings / System). The developer's options appear in the list. Touch the developer options. Choose the USB debugging. 4.2 Run your app on a device Now you can connect your device and run the app from Android Studio. Connect your device to the development machine with a USB cable. Click the Run button in the toolbar.
The Select Deployment Destination window opens with the list of available emulators and related devices. Select your device and click OK. Android Studio installs and runs the app on your device. Troubleshooting If your Android Studio does not recognize your device, try the following: Remove and replace your device. Restart Android Studio. If your
computer still can not find the device or declared "unauthorized", follow these steps: Disconnect the device. On your device, the app works options Developer settings. TAP revokes USB debugging permissions. Reconnect the device to the computer. When requested, grant permissions. You may need to install the appropriate USB driver for your
device. See the documentation using hardware devices. In this task you'll change something about the configuration of the app in build.gradle (module file: app) to learn how to make changes and synchronize them to your Android Studio project. 5.1 Changing the minimum version of the SDK for app Follow these steps: Expand the Gradle Scripts
folder if it is not already open, double-click the Module (build.gradle file: App). The contents of the file is displayed in the code editor. Inside the predefinitoConfig block, modify the value minSdkVersion to 17 as shown below (it was originally set to 15). The code editor displays a notification bar at the top with the Sync Now button. 5.2 Synchronize
the new configuration Gradle When you make changes to Build configuration files in a project, Android Studio requires you to synchronize your project file so that it can import the changes to the configuration setup and run some checks to make sure that the configuration is not will create build errors. To synchronize project files, click Sync Now in
the notification bar that appears when you make a change (as shown above) or click the Sync project with the icon of Gradle File in the toolbar. When the Gradle is finished syncing, the message BULLLE BUSIN BULLING appears in the lower left corner of the Android Studio. For a deeper look of gradle, check the panoramic of the build system and
configuration of the Bulble Builds documentation. In this activity, you will add log instructions to your app, which display messages in the LogCat pane. Register messages are a powerful debug tool that you can use to check values, execution paths and exceptions reports. 6.1 Displays the LogCat pane to display the LogCat pane, click the LogCat tab
at the bottom of the Android Studio window as shown in the following figure. In the figure above: the LogCat tab for opening and closing the LogCat pane, which displays information about your app as it is running. If you add registry registry statements Your app, the log messages appear here. The log layer menu set to verbose (the default value),
which shows all the registry messages. Other settings include debugging, error, information and warning. 6.2 Add log statements to the app log instructions in your App code Displays messages in the LogCat pane. For example: Log.D ("MainActity", "Hello World"); The message parts are: Log: the log class for sending registry messages to the LogCat
pane. D: Setting the debug log level for the filter log message display in the logcat pane. Other registry levels are and by mistake, W for Warn and I for information. "MAINALTY": The first argument is a tag that can be used to filter messages in the LogCat pane. This is commonly the name of the activity from which the message originates. However,
you can make everything that is useful for you for debugging. By agreement, the registry tags are defined as constants for the activity: private static string Private log tag = mainactivity.class.getimpolense (); "Hello world": the second argument is the real message. Follow these steps: Open your Hello World App in Android Studio and open the
Mainativita. To add imports not automatically automatically to the project (such as Android.util.log mandatory for using the registry), select File> Settings in Windows or Android Studio> Preferences in MacOS. Choose Editor> General> Automatic import. Select all check boxes and set Insert imports to everyone. Click Apply, and then click OK. In the
Oncreate () Maineactivity method, add the following statement: log.d ("MainActity", "Hello World"); The OnCreate () method should now seem the following code: @Override protected blank Oncreate (SaviDinstancestate bundle) {SUPER.ONCREATE (SAVIENSTANCESTATE); setcontentview (r.layout.Activity main); Log.D ("MainActity", "Hello
World"); } If the LogCat pane is not already open, click the LogCat tab at the bottom of the Android studio to open it. Verify that the name of the target name and app package is correct. Change the log level in the LogCat pane to debug (or leave the verbose as there are so few register messages). Run your app. The following message should appear
in the LogCat box: 11-24 14: 06: 59.001 4696-4696 /? D / MAINATTIVITY: Hello World Note: All coding challenges are optional and are not prerequisites for subsequent lessons. Challenge: Now that you are set up and familiar with the basic development workflow, perform the following operations: Create a new project in Android Studio. Change the
"world hello" greeting to "happy birthday to" and the name of someone with a recent birthday. (Optional) Make a screenshot of your finished app and e-mail to someone you forgot your birthday. A common use of the log class is to record Java exceptions when they occur in your program. There are some useful methods, such as log.e (), which you can
use for this purpose. Explore the methods you can use to include an exception with a registry message. So, write the code in your app to activate and record an exception. To install Android Studio, go to Android Studio and follow the instructions to download and install it. When creating a new app, make sure that API 15: Android 4.0.3
IceCreamsandwich is set as a minimum SDK. To view the Android hierarchy of the app in the project pane, click the Project tab in the Vertical tab column, then select Android in the top popup menu. Change the Build.gradle file (module: app) when you need to add new libraries to your projects or change the versions of the library. All the codes and
resources for the app are found of the app and the Res. The Java folder includes activities, tests and other components in the Java source code. The RES folder contains resources, such as layouts, strings and images. Edit the AndroidManifest.xml file to add functions and permissions to your Android app. All components for an app, as multiple
activities, must be declared in this XML file. Use the Virtual Device Android (AVD) manager to create a virtual device (also known as emulator) to run your app. Add log instructions to your app, viewing display In the LogCat pane as a basic tool for debugging. To run your app on a physical Android device using Android Studio, activate the USB
debugging on the device. Open settings> Phone information and tap Build number seven times. Return to the previous screen (Settings) and tap the developer options. Choose the USB debugging. Its conceptual documentation is in 1.0: introduction to Android and 1.1 The first Android app. Android Studio Documentation: Other: Gradle Site Apache
Groovy Syntax Gradle Wikipedia Page This section lists possible homework for students who are working through this codeLab as part of a course led by an instructor. It is up to the instructor to do the following: Assign the tasks if necessary. Communicate to students how to present homework. Grade homework at home. Instructors can use these
suggestions as little or as they want, and they should feel free to assign other homework tasks that they believe appropriate. If you're working through this codelab alone, feel free to use these homework to test your knowledge. Build and execute an app creates a new Android project from the empty model. Add registration statements for various
levels of register in oncreate () in the main activity. Create an emulator for a device, aiming at any version of Android you like and run the app. Use filtering in LogCat to find the log instructions and adjust the levels to display only debugging or error registration instructions. Answer these questions Question 1 What is the name of the layout file for
the main activity? MainActivity.java AndroidManifest.xml activity main.xml Build.gradle Question 2 What is the name of the string resource that specifies the name of the application? App _name xmlns: Android app: Applicationid name Question 3 Which tool do you use to create a new emulator? Android Device Monitor Avd Manager Avd Manager
Editor Theme question Question Question 4 Suppose your app includes this registration statement: Log.I ("MainActivity", "MainActivity Layout is complete"); See the statement "Mainaptivity Layout is complete" in the LogCat pane if the Level Level menu is set up on which of the following? (Tip: more Answers are OK.) Verbose Debug Info Warn Error
Assert control control to make sure the App has the following: a business that displays "Hello World" on the screen. Registry declarations in oweed () in the main activity. The log's level in the LogCat pane shows only debugging or error registration statements. To find the next Practical CodeLab during the fundamental Android developers (V2),
consult CodeLabs for the foundations of Android developer (V2). For an overview of the course, including links to chapters, apps and concept slides, see the foundations of Android developers (version 2). [{"TYPE": "thumb-down", "id": "MissingTheInformationINEED", "Label": "The information I need"} is missing, {"type": "thumb-down", "ID":
"TOCOMPLICEDTOOMANYSTAILS", "Label": "Too complicated / too many passages"}, {"Type": "thumb-down", "ID": "OUTOFDATE", "Label": "Out of date"}, {"Type ":" Thumb - down "," id ":" sampleScodeissue "," label ":" emission of samples / code "}, {" Type ":" thumb-down "," id ":" OtherDown "," Label ":" Other "}] [{" Type ":" thumb-up "," id ":"
EasyToundStand "," Label ":" Easy to understand "}, {" Type ":" thumb-up ", "ID": "SOLVEDMYPROBLEM", "Label": "Solved my problem"}, {"Type": "thumb-up", "ID": "OtherP", "Label": "Other"}1}]
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